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Chapter 1: Introduction 
 
1.1 What is TracerPlus Connect? 

TracerPlus Connect is the simplest way for users to transfer data between their TracerPlus enabled mobile 
devices and many other data sources. 
 
TracerPlus Connect is provided on a trial basis to offer hands-on experience with the TracerPlus suite of 
applications before buying. The 5 record limitation of the trial version is removed after purchase and 
registration.  
 

1.2 How It Works 

TracerPlus Connect is an all-in-one solution that allows for both wireless and batch syncing of data to and from a 
wide range of data sources, including MySQL, SQL, Oracle, Microsoft Access, Microsoft Excel, text files and many 
other ODBC compliant databases. 
 

Highlights and Features of TracerPlus Connect 
 

• Support for newer database and field types. 
• Automatic licensing of mobile seats. 
• Greater flexibility for syncing order. 
• Expansive data filtering options. 
• Wireless batch mode. 
• Real-time data transfer. 
• Unattended Windows Service capability. 

 
1.3 TracerPlus Connect Support 

As a registered TracerPlus Connect user, you receive free email support for 30 days from the date you purchase 
TracerPlus Connect. We encourage all users of TracerPlus Connect to visit our Support Center at 
http://www.tracerplus.com/support/ for access to general Knowledgebase, frequently asked questions, training 
videos and other resources intended to speed the learning curve. 
 
Users with Active Support or Maintenance Agreements for their related TracerPlus Mobile Client licenses 
receive unlimited phone and email support of TracerPlus Connect. 
 
PTS also provides a series of free training webinars over the course of the year, with regular announcements via 
email. To begin receiving these announcements, join our Mailing List.

http://www.tracerplus.com/support/
https://www.tracerplus.com/contact
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Chapter 2: Installation 
 
2.1 System Requirements 

• A Windows PC running Windows XP/Vista/7/8/10, or Windows Server 2003/2008/2012/2016. 
• Microsoft .NET Framework 3.5 SP1 or greater (You will be prompted for install if required). 
• Android and iOS devices require a Wi-Fi, WAN or Ethernet connection to the same network the PC or 

Server Connect is being installed to. 
• Windows Devices require Microsoft ActiveSync (Windows XP/Server 2003) or Windows Mobile Device 

Center (Windows Vista/7/8/10/Server 2008/2012/2016) for USB Syncing. 
• At least one Mobile Device with the TracerPlus Mobile Client installed (Matching versions of TracerPlus 

Connect and the TracerPlus Mobile Client are required). 
 

 
2.2 Installation 

1. Download TracerPlus Connect from www.tracerplus.com or an authorized reseller and install to a  
PC that will be used to set up and administer the application. 

2. When the Install Wizard Completed screen appears you have the option to Launch Management  
Studio upon clicking Finish. 

3. Proceed to Chapter 3: Registration for registration and trial instructions. 
 

2.3 Uninstalling TracerPlus Connect 

In the unlikely event that you would like to remove TracerPlus Connect, follow these simple instructions. 
 

1. Exit TracerPlus Connect if open and stop the Sync Service if running. 
2. Open the Control Panel window on your PC. 
3. Select Add/Remove Programs or Uninstall or Change a Program (depending on OS). 
4. Locate TracerPlus Connect and select Uninstall. 

Note: Although not a requirement, we recommend you download and install TracerPlus Desktop for full 
functionality from TracerPlus Connect. 
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Chapter 3: Registration 
 
Chapter 3 describes the limitations of the trial version of TracerPlus Connect, the licensing model and the 
registration process. 
 
3.1 TracerPlus Connect Trial Limitations 

TracerPlus Connect is available as a trial application; this allows potential users to test the functionality of the 
software without purchasing. Trial limitations include: 
 

• Data transfer is limited to five records per synchronization process. 
• The Delete After Transfer feature is disabled (e.g. data cannot be removed from a data set after a 

successful synchronization). 
 

3.2 TracerPlus Connect Licensing Model 

TracerPlus Connect is licensed per seat; a seat is the connection between TracerPlus Connect and a device 
licensed with the TracerPlus Mobile Client. When placing orders for TracerPlus Connect, specify the number of 
seat licenses that you require, this is equal to the number of devices you want to use with TracerPlus Connect. 

3.2.1 TracerPlus Connect Primary and Satellite Installations 
 
TracerPlus Connect is installed as either a Primary or Satellite installation. The primary installation is the 
only installation capable of license administration and should be the first installed. Administration 
includes the issuing and retiring of seat licenses purchased allowing your mobile devices to sync data 
with TracerPlus Connect. A satellite installation is only capable of syncing data. This type of installation 
is commonly used in locations where your mobile devices cannot communicate directly with the Primary 
installation. 
 
The number of installations available to you is equal to the number of seat licenses purchased. This 
consists of a single primary installation and the balance in Satellite installations. 
  

 
3.3 Registering TracerPlus Connect 

TracerPlus Connect is an application that requires registration for full functionality. TracerPlus Connect also 
requires that the connecting mobile devices have registered versions of the TracerPlus Mobile Client (Windows 
Mobile/CE/Windows Embedded/Android). If either of these criteria is not met, TracerPlus Connect runs in trial 
mode. 
 
To purchase TracerPlus software or for more information, please contact your authorized reseller or PTS directly 
at sales@tracerplus.com. 
 

Example: The purchase of a 3 Seat License of TracerPlus Connect enables you to sync with up to 3 mobile 
devices and allows for the installation of one Primary and two Satellites. 

mailto:sales@tracerplus.com
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3.3.1 Registering the Primary License of TracerPlus Connect 
 

1. After purchase, a confirmation email is sent including a Redemption Link. 
2. Note the Redemption Link that corresponds to the TracerPlus Connect Primary license. 

 

 
3. Navigate to ToolsRegistration in TracerPlus Connect and enter the above Redemption Link to 

the Redeem Code field.  
4. Click the Key button to register the software. You should receive a Registration Successful 

Prompt and a registration code should now show in the Registration Code field. 
 

 

3.3.2 Issuing the Mobile Client Seats 
 
After registration has been completed for both TracerPlus Connect and the TracerPlus Mobile Client, 
the device seats must be issued for each device syncing to TracerPlus Connect. By default, the issuing of 
seats is done automatically as the devices connect. To manually issue seats and control the devices that 
can connect, turn off the Issue Device Seats Automatically option on the Tools->Registration screen. 
After registration, devices that are not in the device list will not be authorized to sync with TracerPlus 
Connect. 
 

3.3.3 Permanently Retiring Mobile Client Seats 
 
If you wish to permanently remove a mobile device from the table of assigned devices, you can retire 
the device. Retiring a device allows a new device to be issued in its place. This action cannot be undone, 
and should only be used if a device needs to be permanently replaced. To retire a device, open the 
Tools->Registration form, right-click the Device ID in the assigned devices table and select Retire. This is 
useful in instances where a device is no longer available to your installation (e.g. damaged, stolen, lost, 
etc.). 

3.3.4 Registering Satellite TracerPlus Connect Licenses 
 
To install a satellite copy of TracerPlus Connect, please follow the steps described in Section 3.3.1 
above, selecting a Redemption Link corresponding to one of the provided Satellite licenses. After 
satellite registration is complete, the seat licenses must be exported from the Primary Installation and 
imported into the Satellite Installation(s). This is necessary so that the Satellite Installation(s) has a 
valid list of device seats, allowing the devices to sync with these Satellite(s). 

Note: This confirmation email contains a Redemption Link for this Primary installation as well as your Satellite 
installations. Please be sure to select the correct Redemption Link when making your request. 

Note: If you do not have an internet connection you can register manually by clicking the Redemption Link you 
wish to register and completing the Software Registration form to request a registration code. 

Note: In certain instances, it is necessary to manually issue seats. This could include re-issuing seats in the case 
of a device replacement, or when testing. To issue seats manually, enter the Device ID into the Issue Device field 
of the Tools->Registration form, and click Issue. 
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3.3.4.1 Import/Export of Seat License files 
 
To Export the license file from your Primary Installation: 
 

1. Launch the Primary Installation of TracerPlus Connect. 
2. Select ToolsRegistration and select the Export tab. 
3. Click the Export button. 
4. Select a location and filename for the Export file, and click Save. 

 
To Import the license file to your Satellite installation: 
 

1. Launch the Satellite Installation(s) of TracerPlus Connect. 
2. Select the ToolsRegistration menu option. 
3. Verify that this Satellite Installation(s) is properly registered as discussed above. 
4. Select the Import tab. 
5. Click the Import button, and locate the previously created Export file. 
6. Select the file, and click Open. 
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Chapter 4: Configuring Synchronization Projects 
 
4.1 Creating a New Project 

A Project is a grouping of Profiles and Processes, used to define how data is moved from a data source to a data 
destination. Follow the steps below to create a new Project. 
 

1. In the File menu, select New or click the New Icon on the toolbar. 
2. Proceed to Section 4.2 below to learn how to add a Profile. 
3. To save your project, select Save or Save As from the File menu or click the Save icon on the toolbar. 
4. To open an existing project, choose Open from the File menu or click the Open icon on the toolbar. 

 

 

4.2 Adding Profiles 

A Profile is a grouping of individual data collection processes. A Profile is typically set up to perform a discrete 
set of tasks in which each process is used to perform a specific function. There are two types of profiles, Sync 
Profiles and Live Profiles. Sync Profiles are used to synchronize data between a source and a destination based 
on a defined interval or user action. Live Profiles create an always connected synchronization, where data is 
synchronized with the destination immediately. 

4.2.1 Creating a Sync Profile 
 
A Sync Profile allows data to be synchronized in a batch mode through a wireless or cradled connection. 
The synchronization moves data between a source and destination based on the Sync Processes defined 
within the Sync Profile. When running in a batch environment, the data will be synchronized at timed 
intervals or user initiated syncs. 
 

1. In the Profile Explorer window, click the New Profile icon. 
2. Select Sync Profile from the Create New Profile dialog. 
3. Select the TracerPlus Desktop project being used for this sync profile in the Linked TracerPlus 

Desktop Project field. 
4. Click the Create Profile button to create the profile. 
5. In the Profile Configuration window enter a Name for the profile. 
6. Proceed to Section 4.2.1.1 below to learn how to add processes to your profile. 
7. A profile can be deleted, copied or moved up/down in order using the respective icons in the 

Profile Explorer. 

Note: You can also export a TracerPlus Connect project as a single file (.tce) which can be used for backup 
purposes and portability. To export a project, choose Export from the File menu and select a location to save to.  
 
To import an existing project, choose Import from the File menu and choose the type of import. Choose Close 
Current Project to close the current project and import to a new project. Choose Add to Open Project to add 
the project to the bottom of your currently opened connect project. 
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4.2.1.1 Creating a Sync Process 
 

1. In the Sync Process List window, click the Add Process icon. 
2. Name the Process. 
3. Add a Comment to further detail the process. 
4. Select a Source and Destination for the process (See Section 4.3 for more information 

on selecting a Source and Destination). 
5. Configure Field Mappings as needed (See Chapter 6 for more information on defining 

Field Mappings). 
6. Repeat steps 1-5 to add additional processes. 
7. Save your project. 
8. A process can be deleted or moved up/down in order using the respective icons in the 

Sync Process List window. 
9. A process can be moved to another profile by dragging it to the desired profile. 

4.2.2 Creating a Live Profile 
 
A Live Profile is an always open connection between a TracerPlus enabled device and a data 
destination. In a Live Profile, changes made on a device are immediately posted to the data destination 
in real-time; utilizing the device’s built in Wi-Fi or WAN connection. Changes made to the data 
destination will also be seen immediately by the device. 
 

1. In the Profile Explorer window, click the New Profile icon. 
2. Select Live Profile from the Create New Profile dialog. 
3. Select the TracerPlus Desktop project being used for this live profile in the Linked TracerPlus 

Desktop Project field. 
4. Click the Create Profile button to create the profile. 
5. In the Profile Configuration window enter a Name for the profile. 
6. Proceed to Section 4.2.2.1 below to learn how to configure Live Processes. 
7. A Profile can be deleted, copied or moved up/down in order using the respective icons in the 

Profile Explorer. 

4.2.2.1 Configuring a Live Process 
 

1. In the Session List window, click a Session to configure (This will contain the number of 
sessions available in your linked TracerPlus Desktop project). 

2. Add a Comment to further detail the process. 
3. Select a Live Datasource to be used for the process (See Section 4.3 for more 

information on selecting the Live Datasource). 
4. Add your Key Field (s) using the Add icon. 
5. Configure Field Mappings as needed (See Chapter 6 for more information on defining 

Field Mappings). 
6. Repeat steps 1-5 to configure additional sessions. 
7. Save your project. 
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4.3 Configuring Process Data Sources 

In a process, a data source will need to be specified. When using a Sync Profile, both a Source and Destination 
must be configured for each Process. In a Live Profile, only a Live Datasource should be configured for each 
Session being used. See the sections below for configuring each type of Process. 

4.3.1 Configuring Source and Destination for Sync Profiles 
 
When a sync process is started, the data is transferred from the Source to the Destination. This 
configuration is accomplished via the steps shown below. 
 

1. From the Source tab, select a data type from the Type drop down. 
2. From the Destination tab, select a data type from the Type drop down. 
3. For more information on source and destination types see Chapter 5. 
4. Configure field mappings as needed (See Chapter 6 for more info). 

 

4.3.2 Configuring a Live Datasource for Live Profiles 
 
When using a Live Profile, TracerPlus enabled devices are always connected to the selected Live 
Datasource. In this type of profile, data will be stored and accessed directly from the Live Datasource. 
This configuration is accomplished via the steps shown below. 
 

1. From the Live Datasource section, select a data type from the Type drop down. 
2. From the Key Fields group box, press the Add button to add a Key Field for your data source (At 

least one key field is required). 
3. For more information on data types see Chapter 5. 
4. Configure field mappings as needed (See Chapter 6 for more info). 

Sample Project: 
The example to the left displays a project with three profiles 
containing different sets of processes. Each profile in this 
example demonstrates how profiles can be managed to address 
different business processes in your application. 
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Chapter 5: Configuring Data Types 
 
TracerPlus Connect currently supports the transfer of data between four data Types (ODBC, Excel, Text and 
TracerPlus). Upon making this choice, additional options are presented based on the data Type chosen. 

 
5.1 ODBC Type Settings 

Choosing ODBC allows you to sync data to and from most ODBC databases including (but not limited to) SQL 
Server, MySQL, Oracle and MS Access. When ODBC is selected, the following parameters can be set: 
 

• ODBC Datasource – This is a list of available data sources already configured in the Data Sources (ODBC) 
component of your Windows operating system. Select the desired data source here. 

• Schema – Enter your database Schema name (Optional). 
• Username – If the database requires a username enter it here. 
• Password – If the database requires a password enter it here. 
• Login – Click this button after entering the Username and Password. 
• Table – Populated after selecting the ODBC Datasource and entering the Username and Password, this 

allows you to select the specific table, query, view or stored procedure you want to sync data to and 
from. 

• Configure Advanced options as needed (See Chapter 7 for more info). 
 

 

5.2 SQL Server Type Settings 

Choosing SQL Server allows you to sync data to and from a SQL Server database. This can also be accomplished 
using the ODBC Type described above, however there are some speed improvements when using the SQL 
Server type. When SQL Server is selected, the following parameters can be set: 
 

• Server – The SQL Server data source specified by IP address or host name. 
• Database – The database instance required for the sync process. 
• Schema – Enter your database Schema name (Optional). 
• Authentication – The user authentication type to use to access the SQL Server database. 
• Username – If the database requires a username enter it here. 
• Password – If the database requires a password enter it here. 
• Login – Click this button after entering the Username and Password. 
• Table – Populated after selecting the ODBC Datasource and entering the Username and Password, this 

allows you to select the specific table, view or stored procedure you want to sync data to and from. 
• Configure Advanced options as needed (See Chapter 7 for more info). 

Note: To create a new Windows data source, see APPENDIX A. 
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5.3 Microsoft Excel Type Settings 

Choosing Excel allows you to sync your data to and from a Microsoft Excel spreadsheet. When Excel is selected, 
the following parameters can be set: 

 
• Excel Workbook – Click the Folder icon and select the Excel workbook you wish to sync data to or from. 
• Worksheet – Populated after selecting your Excel Workbook, this allows you to select the specific sheet 

within the workbook to sync the data to or from. 
• Advanced – After clicking the Advanced button, you can set the Start Row in which the data synced 

should start in the excel sheet. This is useful if you have column names and want to start on row 2. 
 

 
 
5.4 Text File Type Settings 

Choosing Text allows you to sync data to and from a text file in a configurable format. When Text is selected, the 
following parameters can be set: 

 
• Select Folder – Click the Folder icon and specify the folder where your text file resides. 
• Filename – Populated after a folder is selcted, this will display all .txt files found in the specified 

directory. Select the text file you wish to sync data to or from. 
• Create File – If the text file does not exist, you can enter the name here and click this button to create 

the file. This file can be named with a .txt or .csv file extension. 
• Configure Advanced options to specify the type of delimiter, set file uniqueness and define field 

attributes (See Chapter 7 for more info). 
 
5.5 TracerPlus Type Settings (Batch sync profiles only) 

Choosing TracerPlus allows you to transfer data to or from your Windows Mobile/CE or Android device. This 
includes both session and dropdown data. When TracerPlus is selected, the following parameters can be set: 

 
• Session – Select a session from the Session drop down. If a TracerPlus Desktop Project has been linked 

to the profile, the session names from that project are populated in this list. If you have not linked a 
TracerPlus Desktop project, this dropdown list is populated with default TracerPlus Session names. 

• Table – Select Session Data from the Table drop down to transfer session data for the selected session. 
If syncing to a drop down field, select the drop down field from this Table list. 

• Configure Advanced options as needed (See Chapter 7 for more information). 
 

Note: When syncing data to an excel sheet, the workbook must be closed for the process to run properly. 
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5.6 Salesforce Type Settings (Batch sync profiles only) 

Choosing Salesforce allows you to sync data to and from your Salesforce online data account. When Salesforce 
is selected, the following parameters can be set: 
 

• Use Sandbox Environment – Enable this to test your Salesforce data syncing in a sandbox environment 
vs. a production environment. 

• Username – This is your Salesforce username. 
• Password – This is your Salesforce user password. 
• Login – Click this button after entering the Username and Password. 
• Table – Populated after selecting the Salesforce Datasource and entering the Username and Password, 

this allows you to select the specific table you want to sync data to and from. 
 
5.7 Active Directory Type Settings (Live profiles only) 

Choosing Active Directory allows you to authenticate users for TracerPlus access. When Active Directory is 
selected, the following parameters can be set: 
 

• Domain –The IP Address or host name of the Active Directory domain to authenticate with. 
• Configure Advanced options as needed (See Chapter 7 for more info). 
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Chapter 6: Source and Destination Field Mappings 
 
Once the Source and Destination have been chosen, the next step in configuring your Process is to map your 
specific data fields in your Source to specific fields in your Destination. As data is transferred row by row, the 
source field data is transferred to the destination field data for each record. Mapping a particular source field to 
a corresponding destination field provides you with a high level of control over the placement of your data. 
 
The Field Mappings are presented in two columns with a variable amount of rows. Each row represents a map 
between the source on the left, and the destination on the right. 

 
6.1 Field Names 

The presented field names for the source and destination datasets can be retrieved from the assigned data set. 
The method for importing the field names varies based on the Data Type you choose. 

 
• ODBC & SQL Server – Field names are automatically retrieved from the table selected. 
• TracerPlus – By default, the field names are generic (Field 1, Field 2, Field 3, etc.). However, specific field 

names can be populated by associating a TracerPlus Desktop Project (.tpp) to the Sync or Live Profile. 
Refer to Section 4.2 for more information on this process. 

• Excel – The field mappings for Excel files can only be associated with the column name of the selected 
worksheet and cannot be changed. Since Excel uses letters to define each column of data, TracerPlus 
Connect displays the Field Mapping as A, B, C, D, etc.. 

• Text – Text files will initially populate the field mapping grid with generic field names (i.e. Field 1, Field 2, 
Field 3, etc.). Field names can be modified by clicking the Advanced button for your Text source or 
destination. See Section 7.3.4 for more information on customizing text fields. 
 

6.2 Mapping Source and Destination Fields 

Each field is individually configurable by clicking the field in the field mappings grid and selecting from the 
presented dropdown menu. 
 
The Field Mappings Toolbar 

Fields and rows can be modified by using the Field Mappings Toolbar. These tools can be used to move and 
delete individual fields, remove entire rows, reset mappings or clear the entire field mapping list. 

• Add Field – This adds an additional field to the mapping for both the Source and Destination. 
• Remove Field – If a particular field is selected, it removes it from the mapping and shifts all fields up. To 

remove an entire row, select the row from the left hand column. 
• Move Up/Down – If a particular field is selected, it moves the field up or down in order. To move the 

entire row, select the row from the left hand column. 
• Reset Mappings – This resets the field mappings to the default state. 
• Clear Mappings – This removes all field mappings. 
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6.3 Advanced Field Mapping Options 

Clicking the Advanced checkbox in the field mappings area will expose some additional settings. If you have the 
UpdateExisting or UpdateExistingAppendIfNotFound option set (See Chapter 7), you can choose what happens 
with data when it is synced form the Source to the Destination. The options are described below. 

 
• Overwrite – This is the default behavior. If the “Advanced” checkbox is not selected, all source fields will 

overwrite their respective destination fields. Please note that these field mapping options are retained 
even if the advanced checkbox is un-enabled. 

• Sum – This option adds the source field data value to the destination field data during a sync. This 
option only works with numeric values. 

• Subtract – This option subtracts the source field data value from the destination field data value during 
a sync. This option only works with numeric values. 

• Do Nothing – This option does nothing to the field during a sync. 
• Do Nothing When Null – This option will do nothing to the destination field’s data if the source field’s 

data is blank or null. 
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Chapter 7: Advanced Configuration Options 
 
7.1 Setting Options for Source Data (Available for Sync Profiles Only) 

Options are available for setting properties on your defined source data such as removing data after a successful 
sync or filtering what data gets sent to the destination. 

 

7.1.1 Delete After Transfer 
 
Select this checkbox to delete the transferred data from the source upon successful sync. This option is 
ignored if there is any error during the sync process. It is also unavailable in Trial Mode. 

 

7.1.2 Source Filtering 
 
Located in the Options tab of the Source settings, adding a Source Filter allows you to control which 
data is synced to the Destination. A typical use for this is sending data to the Destination based on a 
location. To setup Source Filtering, follow the steps below. 
 

1. Click the Add button to create a new filter. 
2. Select a field to filter on from the Field drop down. 
3. Select a Comparison Type: 

a. Equals (=) – Data is only synced when it matches the entered Value. 
b. Not Equal (<>) – Data is only synced when it does not match the entered Value. 
c. LIKE – Data is only synced when it is similar to the entered Value. 
d. NOT LIKE – Data is only synced when it is not similar to the entered Value. 
e. Greater Than (>) – Data is only synced when it is greater than the entered Value. 
f. Greater Than or Equal to (>=) – Data is only synced when it is greater than or equal to 

the entered Value. 
g. Less Than (<) – Data is only synced when it is less than the entered Value. 
h. Less Than or Equal to (<=) – Data is only synced when it is less than or equal to the 

entered Value. 
4. Select the type of filter to be used from the Type drop down: 

a. Static - This allows the user to set a pre-defined filter to use for the sync process. This 
cannot be changed at the time of sync. 

b. Dynamic – This is a changeable filter that is driven from the connected device. This 
allows you to set the filter at the time of sync. See the TracerPlus Desktop manual for 
more information on setting up Dynamic filters. 

5. Enter a Value that you want the filter to match. 
6. To remove a filter, highlight the filter and click the Remove button. 
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7.2 Setting Post Type Options (Available for Sync Profiles Only) 

The Post Type Options allow you to control how the data is posted to your destination. The options available are 
Append, Overwrite, UpdateExisting, UpdateExistingAppendIfNotFound or DeleteExisting and are explained 
below. 

 
• Append – This takes the synced data and adds it to the existing data in your Destination. 
• Overwrite – This takes the synced data and overwrites any existing data in your Destination. 
• UpdateExisting – This takes synced data and updates rows in your Destination based on the Update 

Fields chosen. This does not add any new data if a row is not found. 
• UpdateExistingAppendIfNotFound – This takes synced data and updates rows in your Destination based 

on the Update Fields chosen. This will also add any data rows not found in the Destination. 
• DeleteExisting – This takes synced data and deletes rows in your Destination based on the Update 

Fields chosen. Data that does not match is ignored. 
 

 

 
 
7.3 Data Type Advanced Options 

Additional settings are available by clicking the Advanced buttons in the Source and Destination. Different 
options will appear based on the selected Data Type. 

Note: The AND/OR radio buttons located at the right side of the Source Filtering window are only applicable 
when more than one filter has been configured. This option can narrow results to a more specific set of data by 
either requiring all conditions to be met (AND) or at least one of the conditions be met (OR). 

Example: Route Accounting 
 
Different delivery lists are sent to different devices wirelessly using a central master delivery list. This is 
accomplished by setting a filter using the field in the database designating the driver’s name, a Comparison Type 
of equals (=) and a Value of one of the driver’s names that appears in the database. 
 
Different Processes are created for each driver, with the Job List database as the source and the TracerPlus 
Mobile Client as the destination. The resulting sync profile then sends data to different devices simultaneously 
from a common Job List data table and each device receives different information based on the filtering. 

Note: When selecting one of the two UpdateExisting options, you need to specify fields in which to update the 
row based on. In most cases, this is set to a key field(s) in your Destination. Fields can be added and removed by 
using the Add and Remove buttons. 

Note: When selecting Overwrite, you have the ability to add Destination Filtering. If used, you can specify a 
filter definition to use when deciding which rows in your destination to be overwritten. Rows that match this 
filter will be deleted. If a filter is not specified, then all rows in the Destination will be overwritten. 
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7.3.1 ODBC Advanced Options 
 
In this area you can specify the file path to save signature and image data along with custom database 
date/time formatting. See below for the settings available in this section. 
 

• Binary File Path – This field provides the ability to set a custom save path for binary files such as 
images and signatures transferred during the synchronization. The default location for this 
binary path is C:\Program Files\PTS\TracerPlus Connect 10\Bin. This path will be ignored if data 
is posting directly to an image or blob type field in a database. 

• Custom Database Formats: 
o Date – Set a custom format for syncing date fields. 
o Time – Set a custom format for syncing time fields. 
o Treat DATE types as STRING – This allows your date/time data to be treated as a string 

instead of a date/time data type. 
o Convert signatures to JPEGs – When enabled, converts signatures captured from a .bmp 

to a .jpg file. 

7.3.2 SQL Server Advanced Options 
 
In this area you can specify the file path to save signature and image data along with custom database 
date/time formatting. See below for the settings available in this section. 
 

• Binary File Path – This field provides the ability to set a custom save path for binary files such as 
images and signatures transferred during the synchronization. The default location for this 
binary path is C:\Program Files\PTS\TracerPlus Connect 10\Bin. This path will be ignored if data 
is posting directly to an image or blob type field in a database. 

• Custom Database Formats: 
o Date – Set a custom format for syncing date fields. 
o Time – Set a custom format for syncing time fields. 
o Treat DATE types as STRING – This allows your date/time data to be treated as a string 

instead of a date/time data type. 
o Convert signatures to JPEGs – When enabled, converts signatures captured from a .bmp 

to a .jpg file. 
 

7.3.3 Excel Advanced Options 
 

In this area, you can specify the data starting row and the file path for signature and image data. See 
below for the settings available in this section. 
 

• Binary File Path – This field provides the ability to set a custom save path for binary files such as 
images and signatures transferred during the synchronization. The default location for this 
binary path is C:\Program Files\PTS\TracerPlus Connect 10\Bin. 
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• Start Row – This option allows you to control the row on which the data transfer begins. This is 
especially useful in cases where users have particular information in a header or column title 
row. 

• Auto-detect column data types – When enabled, this feature uses a sample of the Excel data to 
appropriate a data type. This will not work if you use mixed data types in the same column. 

• Convert signatures to JPEGs – When enabled, converts signatures captured from a .bmp to a 
.jpg file. 

 

7.3.4 Text File Advanced Options 
 
In this area, you can specify the type of delimiter to use, set file uniqueness and define field attributes. 
See below for the settings available in this section. 
 

• Delimited – Sets the type of delimiter to use. 
o Tab – Data fields are separated by a tab. 
o Semicolon – Data fields are separated by a Semicolon (;). 
o Comma – Data fields are separated by a Comma (,). 
o Space – Data fields are separated by a single space. 
o Other – Data fields are separated by the character of your choice. 
o Text Qualifier – Surrounds each field of data with an Apostrophe (‘) or Quote (“). 

• Fixed Width – Each field is separated by a set width and is defined in the Text File Fields section. 
• Static File Suffix – Appends the value defined here to the text file name. 
• Create Unique File Suffix – Creates a unique file for each data sync. This is based on a 

FileCounter or DateTime and is appended to the file name. 
• Text File Fields – Define field names and Fixed Width settings here. Fields can be added, 

removed or moved up/down using the navigation bar buttons. 
o Name – Specify a field name for each field. This is useful when mapping fields. 
o Width – Specify the width to be used for each field and is used with the Fixed Width 

option. 
o Alignment – Data can be aligned to the Left or Right when using the Fixed Width 

option. 
• Binary File Path – This field provides the ability to set a custom save path for binary files such as 

images and signatures transferred during the synchronization. The default location for this 
binary path is C:\Program Files\PTS\TracerPlus Connect 10\Bin. 

• Convert signatures to JPEGs – When enabled, converts signatures captured from a .bmp to a 
.jpg file. 
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7.3.5 TracerPlus Advanced Options (Sync Profiles Only) 
 
In this area, you will be able to set the Records per message. By default, this is set to 10. Depending on 
the Data Type, setting this value higher can decrease the time it takes for the sync process to complete. 
Setting this value lower can also help with Timeout Errors during sync. 
 

7.3.6 Active Directory Advanced Options (Live Profiles Only) 
 

In this area, you can specify the user permissions when accessing your TracerPlus sessions. This allows 
you to give access to specific sessions on the handheld based on Active Directory Groups. 
 

• Groups or Usernames – Add Active Directory Users or Groups to this list to specify which user 
or group has access to the selected sessions. 

• Permitted Sessions – After adding Groups or Users to the Groups or Users list box, use the 
Permitted Sessions to turn on or off access to specific sessions using the checkboxes. 
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Chapter 8: Mobile Device and Application Specific Sync Settings 
 
These settings are integrated into the TracerPlus Mobile Client application on the device and are exclusively 
configured within TracerPlus Desktop. Settings include the defining of Hosts, enabling Live Sessions, setting 
Sync Timers and configuring Sync Conditions. For more detailed instructions, see the TracerPlus Desktop User 
Guide. 
 
The options below are configured by navigating to Connect on the project navigation bar in the TracerPlus 
Desktop application. 
 
8.1 Hosts 

A host is a PC or Server that is running the TracerPlus Connect software. This allows a mobile device to connect 
to a specific TracerPlus Connect installation. To add a host, click the Add button and configure the settings 
below. A host can be removed by highlighting the row and clicking the Remove button. 
 

• ID – Auto populated with a unique value, this Host ID is referenced when configuring Live Sessions (see 
Section 8.2 below) and the DoSync (see Section 9.2.1) button action. 

• Host Name/IP Address – This is set to the IP Address or PC Host Name of the PC or Server on which 
TracerPlus Connect is running. 

• Port – The network port is used along with the Host Name/IP Address to make a connection to 
TracerPlus Connect. By default, TracerPlus Connect uses port 4403 for the Management Studio and port 
4404 for the Sync Service (see Chapter 11 for more information on setting up the Sync Service). 

  
8.2 Live Sessions 

Live Sessions allow the sessions in your TracerPlus Desktop project to operate in a live, real-time mode. To add 
a Live Session, click the Add button and configure the settings below. A Live Session can be removed by 
highlighting the row and clicking the Remove button. 
 

• Enabled – Enables the selected session for Live Mode. 
• Session – The Session from your project to be used in Live Mode. 
• Host ID – The ID of the host defined in the Hosts (see Section 8.1 above) section. 
• Profile ID – The Live Profile to use as configured in TracerPlus Connect. 

 
8.3 Sync Timers 

Sync Timers allow setting of a time period at which a device sends or receives data without user interaction. The 
timer starts when TracerPlus is first opened and resets when TracerPlus is closed on the mobile device. 

 
• Enabled – When enabled, this timer is active whenever TracerPlus is running on the device. 
• Interval – The Interval defines how often this sync timer triggers while TracerPlus is running. This value 

is measured in seconds. 

https://www.tracerplus.com/sites/default/files/TracerPlusDesktop_UserGuide.pdf
https://www.tracerplus.com/sites/default/files/TracerPlusDesktop_UserGuide.pdf
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• Host ID – The Host ID identifies which host is used for the sync initiated by the timer. The Host ID refers 
to the ID as configured in the Hosts Tab. 

• Profile ID – The Profile ID identifies which TracerPlus Connect profile should be used for the sync 
initiated by the timer.  

 
8.4 Sync Conditions 

Sync Conditions define the conditions that need to be met to allow a synchronization to occur. Two condition 
types can be set, DateTime and Database Count. These are used to control either a Timed Sync or a sync 
initiated by a DoSync button action. 

 
DateTime Condition 
The DateTime condition enables a sync to only run before or after the specified time. If a specific window 
of time is required, that can be accomplished by using two unique DateTime Conditions; one specifying the 
earliest start time (After) and one specifying the latest start time (Before). 

 
• Before/After – Select whether the time evaluation should be before or after the specified time. 
• Time – Enter the time to use in this evaluation. 
• Message – A custom message to display when a sync condition fails and the sync will not run. 
 

Database Count Condition 
The Database Count Condition controls when a synchronization can occur based on a session record count. 

 
• Session – Select the project session to use for the record count evaluation. 
• Records – Select the operator to use for the record count evaluation. 
• Value – Select the value for the record count evaluation. 
• Message – A custom message to display when a sync condition fails and the sync will not run. 
 

Name 
This is the name of the Sync condition. The user can rename a Sync condition rule here. 
 
Profile ID 
The Profile ID identifies which TracerPlus Connect profile should be used for the sync initiated by the timer.  

 
8.5 Sync Feedback 

Sync Feedback allows users to enable the Sync Progress dialog on the TracerPlus Mobile Client. 
 

Display Sync Progress 
Check Display Sync Progress to enable the displaying of a syncing progress dialog. 
 
Auto close sync progress in 
The amount of time the sync progress window remains open after a completed sync. After a successful 
sync, the user can also select the Close button. Setting this to “0” forces the user to close the sync dialog.



Chapter 9: Synchronizing Data 

TracerPlus Connect                         Developed by Portable Technology Solutions 25 

Chapter 9: Synchronizing Data 
 
Once your Profiles have been configured, you are ready to synchronize your data. Data synchronization can be 
triggered using the synchronization form of the TracerPlus Connect Management Studio (Windows Mobile/CE 
only), or though the device sync settings (recommended) described in Chapter 8. 

 

9.1 Synchronizing Using the TracerPlus Connect Management Studio 

Click the Synchronize tab to open the Synchronization screen. This screen contains two main sections; the 
Profile Synchronization tab section and the Activity Monitor. 

9.1.1 Profile Synchronization 
 

The Profile Synchronization section organizes your Profiles in a tabbed format. This screen allows you to 
perform either Profile syncs or syncs of each Process individually. In order to sync data with a device 
using the sync screen, the device must be cradled to the host PC (Windows Mobile/CE only). 
 

Sync All 
This option syncs all of the process in the selected profile. 
 
Sync Selected 
This option syncs only the selected process in this profile. 

9.1.2 Activity Monitor 
 

The Activity Monitor provides information about syncs as they are being performed as well as the 
current status of the Sync Server. 

 
Sync Activity 
This screen displays information during a sync as it occurs. It also displays any real-time clients 
currently connected. Information provided includes the client address, Profile and Process names 
and the progress of the sync. To cancel a sync while in progress, right-click the sync in the Activity 
table and click Cancel. 

 
Server Status 
This tab shows cumulative statistics tallied since the server connection was last started. 

 
9.2 Synchronizing Using the TracerPlus Mobile Client 

In many cases, the syncing of data is not performed while the device is cradled, but over a wireless network 
connection. In this case, the synchronizations are triggered by the mobile device; either by button action or a 
timed sync. 

9.2.1 Data Synchronization by Button Action 
 

To initiate a sync via a button action, a DoSync button is required on the form. Additional information 
on how to configure a DoSync button can be found in the TracerPlus Desktop user guide. 

https://www.tracerplus.com/sites/default/files/TracerPlusDesktop_UserGuide.pdf
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9.2.2 Data Synchronization by Sync Timers 
 

To automatically initiate a sync on a specified interval, a Sync Timer must be configured in the 
TracerPlus Desktop project. Additional information on how to configure a Sync Timer can be found in 
the TracerPlus Desktop user guide. 
 

Note: When performing either manual or timed syncs initiated from the client side to the TracerPlus Connect 
Management Studio, the Studio must be open and the Server must be running. An Alternative to leaving the 
TracerPlus Connect Management Studio running is using the TracerPlus Connect Sync Service discussed in 
Chapter 11. 

https://www.tracerplus.com/sites/default/files/TracerPlusDesktop_UserGuide.pdf
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Chapter 10: Application Preferences 
 
The Preferences dialog box contains sections for additional configuration of the TracerPlus Connect 
Management Studio and the TracerPlus Connect Sync Service. This dialog can be opened using 
ToolsPreferences. 
 

10.1 TracerPlus Connect Management Studio Settings 

Default Project Location 
Use this field to set the Default Sync Project Location for saving and opening TracerPlus Connect projects. 
 
Start Sync Server on Application Startup 
This checkbox toggles whether the TracerPlus Connect Sync Server starts automatically when the TracerPlus 
Connect Management Studio is launched. 
 
Sync Server Port 
This field sets the port to be used for syncs using the TracerPlus Connect Management Studio. The default 
setting for this port is 4403. 
 
Sync Server Logging Level 
This dropdown sets the level of detail that is recorded in the TracerPlus Connect Management Studio Event 
Log. See Section 10.4 for more information on logging choices. 

 
10.2 TracerPlus Connect Sync Service Settings 

Active Connect Project (.tcproj) 
Use this field to set the TracerPlus Connect project to use for the TracerPlus Connect Sync Service. Click the 
Use Current Project button to select the currently opened project. 
 
Sync Service Port 
This field sets the port to be used for syncs using the Windows Service. The default setting for this port is 
4404. 
 
Sync Service Logging Level 
This dropdown sets the level of detail that is recorded in the TracerPlus Connect Event Log. See Section 10.4 
for more information on logging choices. 
 
Service Start Delay Time (Seconds) 
Upon starting the service, you can set a delay in seconds of when the service should start connecting to the 
database allowing the database service to fully start before the Connect Sync Service starts. 
 

10.3 General Network Settings 

Encrypt Data 
Check the Encrypt Data checkbox in order to encrypt sensitive data with 128 bit AES encryption. 
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Read Timeout 
Sets the client timeout value. This value specifies how long the client will remain connected with no server 
activity. 

 
10.4 Event Logging Options 

TracerPlus Connect provides event log files for both the TracerPlus Connect Management Studio and the 
TracerPlus Connect Sync Service. Event logging provides system administrators with important information by 
recording any network failures or other errors that may occur during the syncing process. The level of reporting 
can be set by choosing from a series of options ranging from no reporting, to extremely detailed. 

 
To view the event log, select View from the Menu and then select Event Log. To access the log archive, click the 
Open Log File button. 

 
• None – If None is selected, no information is logged. 
• CriticalError – If Critical Error is selected, only errors relating to significant sync problems or connection 

loss are recorded. 
• Error – If the Error level is selected, the event log records all instances of both significant and smaller 

errors. 
• Warning – If Warning is chosen, additional information regarding network issues which did not cause 

transmission errors is added to the event log. 
• Info – If Info is selected, all primary connection and syncing events are logged. This includes all 

successful data transfers. 
• Verbose – If Verbose logging is chosen, all syncing actions taken by TracerPlus Connect will be logged in 

detail. 
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Chapter 11: TracerPlus Connect Sync Service 
 

The TracerPlus Connect Sync Service offers users the ability to run TracerPlus Connect as a Windows Service. 
The primary advantage of the Sync Service is the ability to perform syncs without the need to log in to the host 
PC. 
 
11.1 Setting up the TracerPlus Connect Sync Service 

To set up the Sync Service, a TracerPlus Connect Project must first be configured as described in Chapter 4. 
After your TracerPlus Connect Project file is saved, follow the steps below to designate that project as the active 
project for the Sync Service. 

 
1. Open the TracerPlus Connect Management Studio then select ToolsPreferences. 
2. Select the project file to use for the Sync Service in the Active Connect Project (.tcproj) text box. You 

can use the Use Current Project button to automatically select the current project open in Management 
Studio. Please make sure that this project is in a location accessible to the sync service. 

3. Enter the port that your network will use for the Sync Service. The default is 4404. 
4. Select the appropriate level of event logging for the Sync Service. For more information on event 

logging, see Section 10.4. 
5. Click OK. 

 
The Sync Service is integrated into the Windows Service environment. These applications do not have a user 
interface and any user messages are written to the TracerPlus Connect Event Log. These Services can be 
automatically started when the computer is booted and does not require a logged in user in order to run. 

 
11.2 Starting and Stopping the TracerPlus Connect Sync Service 

The TracerPlus Connect Sync Service is set to run automatically as the default, and will start up upon re-boot. In 
addition, a checkbox starting the Service is available during the installation of TracerPlus Connect. Although the 
service can be considered “always on”, no sync operations are performed unless a file path to a properly 
configured .tcproj is set. 

 

 
The TracerPlus Connect Sync Service can be manually started or stopped by navigating to the Start/Stop Service 
link located in the Windows Start menu. The service can also be restarted by right-clicking the TracerPlus 
Connect Tray Monitor located in the Windows System Tray. 

Note: If changes are made to the configuration of the Sync Project being used by the Sync Service, a restart of 
the Sync Service is required in order for the Sync Service to recognize the changes. 
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Chapter 12: Viewing Data within TracerPlus Connect 

The TracerPlus Connect Data Viewer provides a simple, read-only view of the source and destination data. The 
Data Viewer provides a set of tabs with all available Profiles contained in the TracerPlus Connect project. The 
active tab displays a selectable grid containing a list of all Processes included in the selected Profile. 
 
This grid provides a quick option for selecting a Process to view the source and destination data. Once a process 
is highlighted, the data for that process is displayed in the Source/Destination Data tabs below. Click the 
Refresh button to update the data in this table. 
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Appendix A: Connecting to an Existing Database 
 
A.1 Creating a New Data Source Name to Connect to an Existing ODBC Database 

1. Navigate to and open the Control Panel window. 
2. Select the Administrative Tools Icon. 

 

 
3. Double click the Data Sources (ODBC) icon. 

 

 
 
4. Select the System DSN tab, and click the Add button. 

 

 
 

Note to users of 64 bit Windows PCs: Users must use the 32 bit ODBC admin tool. Rather than locating 
this panel as described above, navigate to the C:\Windows\SysWOW64 folder and double click the 
odbcad32.exe file. Then proceed to Step 4 listed below. 
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5. Select the appropriate driver based on the database type you wish to use. If the desired driver is 
not present, consult your database user guide on how to install the proper driver. 

6. Click Finish. 
7. This will open the database Configuration window. Enter the relevant information about your 

DSN, and select the database file. The method for selecting the database will vary based on 
which type you are using. Refer to the built in Windows Help or your database user guide for 
additional information. 

8. After completing the configuration, Click OK to close the ODBC Data Source Administrator 
control panel. 

9. The database is now configured and will appear in the OBDC Datasource dropdown in 
TracerPlus Connect. If the database name is not visible, click the Refresh Button to update the 
dropdown list. 
 

A.2 Using the TracerPlus Sample Database File 

TracerPlus Connect is pre-configured with a sample database connection to Microsoft Access (.mdb). 
This file is automatically included in the ODBC Datasource dropdown for the ODBC data type and listed 
as TracerPlus Connect Sample. Its default location is: C:\Program Files\PTS\TracerPlus Connect 
10\Data. For 64 bit PCs, the location is C:\Program Files(x86)\PTS\TracerPlus Connect 10\Data. 
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